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SSIS Coding Manual 
 
What is the SSIS measuring? 
The variable collected from the SSIS represents the child’s ability to imitate gestures and play 
actions. 
 
Select the Media 
Consult the ImPACT Coding Log to determine which video to code.  The log is located at the following 
location:   
 

Krupa → ImPACT Study → Assessment Team → Coding → ImPACT Coding Log.xlsx (SSIS Tab) 
 
Procoder 
Procoder will be used to playback the media and to make notes about the child’s behaviors during each 
trial, while you manually code the SSIS using a score sheet. 
 
Please see the following information for setup, general use, and keyboard shortcuts. 
 
A. Setting Options for Procoder 

1. Open Procoder.  The Procoder menu bar looks like the following: 
 

 
 

2. Select ‘Edit > Options’ to get the following dialogue box: 
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3. Select the ‘Media Control Options’ tab and the settings: 

a. ‘Time Display’ → ‘Display in HH:MM:SS.ss’ 

b. ‘Frames Per Second’ → 29.97 

c. ‘Replay controls’ → ‘Play pre-roll/post roll around the event’ 

d. ‘Event Pre-Roll’→ 3 

e. ‘Event Post-Roll’ → 10 

 

 

 

4. Copy the media file that corresponds with the selected assessment from the media server (NAS-2) 
onto your hard drive 

a. NEVER link a Procoder transcription file with a media file on the media server. Doing so 
can result in corrupting the media file. 

b. Store the copied media file into a designated folder on your desktop. 
c. Remove the media from your desktop folder after you’ve completed coding by placing it in 

the Recycle Bin. The original media file will still be accessible on the network.   
 

B. Using Procoder to code your media 

1. Open Procoder 

 

2. Open a new transcription data file by selecting ‘File > New > Transcription Data File’ 

 

3.  Name the transcription file using the following convention, separating each component with a 

hyphen. 

a. Site initial + Research ID# (V101, U309) 

b. Time of visit (T1, T2, T3, T4) 

c. Procedure initials (SSIS) 

d. Coder’s initials, first and last 

e. End the file name with “-reliability” if this is a reliability check by a second coder. 
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f. Save the file to a designated folder on your computer.   

a. “V104-T1-SSIS-ec” for a primary coded file or “V107-T1-SSIS-mw-reliability” for a 

reliability coded file. 

 

4.  Fill out the information in the ‘File Info” tab (illustrated below): 

a. ‘Subject Identifier’ → Site initial + Research ID# (Ex: V104, U304) 

b.  ‘Session Date’ → Date of Assessment (MM/DD/YY) 

a. You may have to watch the beginning of the video to get the date from the assessor’s 

announcement, then go back and fill in this information.  

c. ‘Session Time’ → The time-visit of the appointment 

a. In the Impact Study, the SSIS occurs at each Time period (T1-T4). 

d. ‘Location’ → The initials of the site where the assessment was recorded 

a. Vanderbilt University = “VU” 

b. University of Washington = “UW” 

e. ‘Session Code’ → The initials of the assessment (SSIS) 

f. ‘Observer/Coder’ → Your initials 

g. ‘Date Started’ → Date you began coding this file 

h. ‘Date Completed’ → Date you finish coding the file 

a. While you can start coding a file and finish it at another time, be certain that the length 

of time between ‘Date Started’ and ‘Date Completed’ is no longer than two days.  Never 

start coding a file on a Friday afternoon if you cannot finish coding it before the weekend. 

 
 
5. Link the media file 
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a. Under ‘Media File’ in the ‘File Info’ tab, select the ‘Browse’ button. 
b. Browse to where you saved your copy of the media file and select the target video. 

 

C.  Procoder Controls and Keyboard Shortcuts 

1. Getting Ready to Code 

a.  Make the media file visible 

a. Select the ‘Media’ button (it has an image of a hand holding a camcorder over the label 

‘Media’) – this should make the media file open through Procoder. 

 

b.  In order to play the video while you manually code the SSIS, you must click on the Data tab 

at the top of the Procoder File box:  

 

 

 

c.  Now you will have a Video screen where your media is displayed and a Transcription screen 

that looks like this: 
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2.  Controls while coding 
a.  To begin playing media 

▪ Use the mouse and place your cursor in any cell of the Transcription screen (Time, Codes 

or Transcription).  In order to manipulate the video, your cursor must always be in a 
cell in the Transcription screen or framing the cell with a bold border. 

 

▪ Press Ctrl+D on the keyboard. 
 

b.  To stop playing/pause media 

▪ Make sure the cursor is in the ‘Time,’ ‘Codes,’ or ‘Transcription,’ cells in the transcription 
window. 
 

▪ Press Ctrl+F on the keyboard. 

c.  To stop the media and make a note in Procoder or to time an event, make sure your cursor is 
in the correct position (not highlighting a cell blue, but rather framing it with a bold border). 

▪ Press Ctrl+X on the keyboard. 
 

▪ The video will stop at the time mark you’ve selected. 
 

▪ The time will display in a newly created row at the bottom of the transcription rows. 
 

▪ You may click in the cell and write an observation. 
 

▪ This time also serves as the “pivot” for REPLAY and SEEK features in Procoder. 

 

▪ To use this feature to time an event, you will press Ctrl+X at the beginning of the event, 
press Ctrl+D to play the video, and then press Ctrl+X again to mark the end of the 



Version date:  8/26/16 

 

7 

 

event.  This will allow you to calculate how long it took the child to complete the play 
action coded for this measure (if needed). 

 
d.  To pre-roll the media in 3-second intervals 

▪ Begin by pausing the media by pressing Ctrl+F, then press Ctrl+B to pre-roll the media 
in 3-second intervals.  You may use Ctrl+B multiple times in a row to locate the event you 
would like to view. 

 
3.  List of keyboard controls to manipulate media playback 

 Ctrl+A = Pre-roll (3 sec.) & stop (at 10 seconds) 

 Ctrl+B = Pre-roll & play (3 sec. pre-roll that continues to play until stopped) 

 Ctrl+D = Play 

 Ctrl+E = Mark (no stop) 

 Ctrl+F = Stop 

 Ctrl+G = Go to start 

 Ctrl+H = Hide or unhide selected columns 

 Ctrl+K = Delete current row 

 Ctrl+N = Insert a row 

 Ctrl+M = Add a row 

 Ctrl+R = Find/Seek 

 Ctrl+X = Stop & mark 

 F5 = ¾ speed 

 F12 = Sort Data Grid by time 

 

 

The Procedure 

The SSIS consists of 10 items, divided into two scales.  The Object Imitation Scale consists of 5 play 

object items and the Gesture Imitation Scale consists of 5 gesture items.  The examiner administers one 

scale at a time in no particular order.  After the object or gesture demonstration, which is accompanied 

with a verbal marker, the examiner waits for a response from the child.  Each item is demonstrated 

three times (trials) and the examiner begins each trial with the phrase “Watch me!”  The child’s response 

is scored for each trial; however, only the highest scored trial is used to compute the total score.  See 

the score sheet below for an example. 

 

During the SSIS there is a 5-minute, warm-up activity, where the examiner imitates the child with a 

variety of toys.  The warm-up activity is not coded at Vanderbilt.  At the conclusion of the warm-up 

activity, the examiner will remove some toys and leave a few items out.  Coding begins when the 

examiner prompts the child with the carrier phrase, “Watch me!” followed by an Object or Gesture 

item from the score sheet. 

 

The SSIS is complete after all 10 items (5 Object Imitation and 5 Gesture Imitation) have been 

administered or the examiner says “stop coding here.” 
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Coding Guidelines:  Also see Appendix A 

 

For each trial presented, child responses will be assigned a score ranging from 0 to 2, depending on 

the extent to which child’s response resembles the target acts below.  Imitation behaviors performed 

when the child’s back is to the camera can still be coded if the child’s response is at least partially 

visible to the coder. 

 
OBJECT SCALE 

 
Sound tube (Whee!) 
-Picks up tube and the tube automatically makes noise w/o child turning it = 1 
 
-Shaking it back and forth without wrist rotation = 1 
 
-Moving the sound tube by rotating the wrist 1x.  Not flexion and extension. = 2 
 
 
Train (Oh no!) 
-Drives it w/o dropping it = 0 
 
-Pushes it toward edge w/o dropping off = 1 
 
-Pushes train at least an inch, then it drops off table = 2 
 
 
Slinky (Look!) 
-Puts on nose but does not extend it = 1 
 
-Puts it on interactant’s nose = 1 
 
-Puts on nose and extends it = 2 
 
 
Fish & Net (I got it!) 
-Puts fish in examiner’s net = 1 
 
-Puts something else in net = 1 
 
-Puts fish in own net = 2 (Do not need to shake or swing net around) 
 
 
Tambourine and jingle bells (Ta Da!!) 
-Hits hand on tambourine = 1 
 
-Hits shaker on something else or hits something else on the tambourine = 1 
 
-At least one hit w/ shaker on tambourine = 2 
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GESTURE SCALE 
 
Finger to lips (Shh, Baby’s sleeping) 
-Says shh w/o gesture = 0 
 
-Finger to lips w/o “shh” = 2 
 
 
Clap (Yay, I did it!) 
-Says “Yay, I did it” = 0 
 
-One clap; the child’s hands are open and come together at midline = 1 
 
-At least two claps = 2 
 
 
Point (It went over there!) 
-Says “It went over there!” = 0 
 
-Points = 2 
 
 
Hands up and pant (I’m a dog) 
-Says “I’m a dog” = 0 
 
-Panting = 1 
 
-Hands up (with or w/o panting) = 2 
 
 
Finger in circle (It’s spinning!) 
-Says “It’s spinning” = 0 
 
-Attempts to move fingers or hand in a circular motion; during the child’s attempt at the circular motion, 
their fingers or hands return to the starting point of the motion = 2 
 

 
Marking Time & Using the Score Sheet 
When using Procoder, follow this procedure to make notes about the child’s behavior.  These notes will 
aide in the manual scoring of the items on the score sheet. 
 
1. Mark (using Ctrl+X) when:  

The examiner begins the first trial and note the item administered. 
 
2.  Mark (using Ctrl+X) again: 

AFTER the end of the first trial administration (usually indicated by the end of the examiner’s 
verbal marker).  In the transcription field, note the child’s behavior in response to the first trial. If 
you find it helpful, you may indicate the score for each trial in the “Codes” column. 
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3.  Mark (using Ctrl+X) again: 

AFTER the end of the second trial administration and before the child’s response. Follow the same 
notation procedures for child response and scoring. 
 

4.  Mark (using Ctrl+X) again: 
AFTER the end of the third trial administration. This will be the time-point used for calculating the 5 
second window allotted for a child’s response during the third trial. 
 

5.  Mark (using Ctrl+X) the LAST time: 
AFTER 5 seconds have passed.  If the child’s response to the examiner’s model occurs outside of the 
5 second window, it is not coded. Write “End of T3” in the transcription field to indicate the end of 
the item administration. 

 
6.  Once you have made notes regarding the child’s behavior for EACH trial, score the trials on the SSIS 

Score Sheet according to the Coding Guidelines noted above.  Then continue watching the next item 
administered. 
 
Complete these six steps for all 10 items.   

 
Coding Clarifications 
 
Any response—meeting coding criteria—that the child makes after an item’s first model and up until 5 
seconds after the third model is considered codeable. This includes simultaneous and pre-emptive 
imitation to the examiner’s second and third models. 
 
If the examiner hands items to the child after modeling a gesture/toy movement, the child’s response 
cannot be coded because the examiner has inadvertently prompted the child.  However, if the child is 
reaching for the adult’s toy after the examiner models a gesture/toy movement, the examiner may give 
her toy to the child and the child’s response CAN be scored. 
 
If the child imitates the appropriate gesture or toy movement but does not engage with the materials, 
the child’s response CAN be coded.  For example, the child imitates clapping without attending to the 
blocks.  The SSIS is a measure of the child’s ability to imitate the specific gestures or toy movements 
being assessed, not imitating everything the examiner demonstrates during a model. 
 
For scoring the slinky item: The child only receives 2 points if the slinky begins on the nose in a collapsed 
state and is then released/expanded while still being anchored to the nose. Any extension of an 
already (even partially) expanded slinky that is set on the nose will only receive 1 point. 
 
For scoring the train item: The edge referenced in the coding guidelines can refer to any edge of any 
surface from which the train can be pushed to the ground. Whether the child pushes the train off a 
different edge of the same surface as the examiner’s model or the edge of a completely different 
surface is inconsequential. 
 
For scoring the fish & net item: If the child’s net is laying on the ground and the child puts a fish on the 
net (without picking the net up), the child receives 2 points for the trial. In the net and on the net will be 
coded the same in this instance. 
 
Your Procoder file and accompanying Score Sheet will look like this (see below): 
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The total score from the Score Sheet is entered into REDCap. 
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SEMI STRUCTURED IMITATION SCALE 

GESTURE & OBJECT IMITATION ASSESSMENT 

Id_V105___     Time Period  __2___  Date_10/4/15          ____________ 

Examiner ______________________  Scorer ___CB____________________P    R 

 
TOY SET 

ONE 
ACTION VERBAL MARKER 

TRIAL 
1 

TRIAL 
2 

TRIAL 
3 

SCORE 

Sound tube 
Turn upside down 2 
times 

Whee! 0 0 N/A 0 

Train Let train roll off table Oh no! 0 0 0 0 

Slinky 
Put slinky on nose and 
drop 1 end 

Look! 0 0 0 0 

Fish & Net Drop fish in net I got it! 0 0 0 0 

Tambourine 
& Jingle 
bells 

Hit tambourine with 
bells 2 times 

Ta Da!! 0 0 0 0 

 

TOY SET 
TWO 

PLAY 
ACTION 

GESTURE VERBAL MARKER 
TRIAL 

1 
TRIAL 

2 
TRIAL 

3 
SCORE 

Baby & 
Blanket 

Cover 
baby with 
blanket 

Finger to 
lips 

Shh, Baby’s sleeping 0 0 0 0 

Blocks 
Make 
tower of 
3 blocks 

Clap Yay, I did it! 0 0 0 0 

Car 
Push car 
across 

Point to 
car 

It went over there. 0 2 2 2 

Dog Show toy 
Hands up 
and pant 

I’m a dog. 0 1 0 1 

Top Spin top 
Finger in 
circle 

It’s spinning. 0 0 0 0 

**NOTE:  THE CHILD IS NOT SCORED ON WHETHER THEY IMITATE THE PLAY ACTIONS.  
THESE ARE JUST USED BY THE EXAMINER TO PLACE THE GESTURES IN CONTEXT 

Total 
Score 

 
3 

                                                                                                       Entered into REDCap 
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When a trial is missing: 
There may be occasions when an examiner administers fewer than 3 trials for a particular item.  In this 
case, use the highest scored trial for that item as the final score.   
 
When one or two items are missing: 
If the examiner fails to administer one or two entire items, i.e. all three trials for each item are omitted, 
then the child receives a score of 0 for the item.  The remaining items are summed to compute the total 
score.   
 
When MORE than two items are missing: 
If the examiner fails to administer three or more items, the SSIS cannot be scored, and the coder should 
enter 555 on the score sheet and into REDCap.  
 

If any of these scenarios occur, please alert the examiner so they can be mindful in the future of 

following the protocol.  

 

Coder Protocols: 

A. Determine who will be the primary coder and who will perform reliability checks (or be the 

“reliability coder”). 

1. The primary coder will do the majority of coding, but both primary and reliability coders should 

follow all “Coder Protocols.” 

2. It is possible for there to be more than one primary coder. The primary coders will then be 

responsible for completing regular reliability checks on one another.  

 

B. Code in a quiet place with the headphones pre-approved by your PI.  

1. Use Sony Professional MDR-7506 

2. Never use earbuds or non-approved headphones to code a sample 

3. Limit distractions:  

a. Turn cell phone on silent/off, minimize/close-out email, close door, and keep noises in office 

to a minimum.  

b. Never code while listening to music 

 

C. Viewing Items 

1. You may watch each trial up to 3 times (if needed) in order to determine how the child 

responded to the examiner’s model. 

2. Do not view each trial more than 3 times because it may interfere with reliability.  You should be 

able to make an informed decision after watching the trial up to 3 times. 

 

D. Finishing a Primary coded file: Once a video file has been completely coded through 

ProcoderDV, take the following steps: 

1. Save the primary .pdv to a specific folder designated on your computer. 

2. Place a copy of the completed .pdv file on the network:  

▪ Krupa → Impact Study → Assessment Team → Coding → SSIS Coded Files 
3. Delete the copy of the video from your computer (NOTE: the video should still be saved on 

PRSA4!).  
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4. Enter the following information into the Impact Coding Log: 

a. Initials 

b. Date coded 

5.  Ensure your SSIS Score Sheet is completed and placed in the appropriate location (to be 

determined by coding staff). 

 

E. Reliability 

1. In this project, 20% of all coded files will be coded for reliabilty; once a set of 5 video files has 

been collected, one of the 5 files will be selected randomly for reliabilty.  

a. To be considered reliable, the ratio of the total scores from the primary and reliability 

samples must be greater than or equal to 0.85 (small/large). 

b. All agreement checks during the first year of coding for the Impact Study need to be 

followed by a discrepancy discussion of items that are scored differently.  Discrepancy 

discussions are to serve as a training context and an attempt to improve the coding manual.  

After the first year of coding (or staff hiring period), discrepancy discussions can be limited 

to sessions at which lower than .85 small/large ratio is derived. 

 

F.  Finishing a Reliability coded file:  Once a reliability video file has been completely coded through 

Procoder DV, take the following steps: 

1. Save the reliability .pdv to a specific folder designated on your computer. 

2.  Place a copy of the completed .pdv file on the network:  

▪ Krupa → Impact Study → Assessment Team → Coding → SSIS Coded Files 
3.  Delete the copy of the video from your computer (NOTE: the video should still be saved on 

PRSA4!).  

4. Enter the following information into the Impact Coding Log: 

a.  Initials 

b.  Date coded 

c.  Reliability ratios 

 

G.  Data Entry:  After reliabilty for the selected file is complete, the set of 5 files will be ready for data 

entry. See the REDCap data entry manual for further instructions. 

 

H.  Unreliable files 

1. If the file is unreliable, each coder must stop coding samples until the two coders can meet to 

discuss all discrepancies between the files. 

 

2. Together, the primary and reliability coders will discuss the coders’ discrepancy forms and review 

the video file side-by-side.  

 

3. If the discrepancies are large, they may choose to code the video file side-by-side to create a 

consensus file. 

▪ Labeled: Project ID – Time period – Test name - Coders’ initials – consensus 

▪ Ex: V103-T1-SSIS-mwec-consensus 
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4. If the two coders have three consecutive files that are unreliable, both coders must retrain and 

obtain three consecutive files at reliability before they can code again independently as primary 

coders. 

 

 

 



Version date:  8/26/16 

 

16 

 

Appendix A:  Coding Guidelines 

OBJECT SCALE 
Sound tube (Whee!) 
-Picks up and the tube automatically makes noise w/o child turning it = 1 
-Shaking it back and forth without wrist rotation = 1 
-Moving the sound tube by rotating the wrist 1x.  Not flexion and extension. = 2 
 
Train (Oh no!) 
-Drives it w/o dropping it = 0 
-Pushes it toward edge w/o dropping off = 1 
-Pushes train at least an inch, then it drops off table = 2 
 
Slinky (Look!) 
-Puts on nose but does not extend it = 1 
-Puts it on interactant’s nose = 1 
-Puts on nose and extends it = 2 
 
Fish & Net (I got it!) 
-Puts fish in examiner’s net = 1 
-Puts something else in net = 1 
-Puts fish in own net = 2 (Do not need to shake or swing net around) 
 
Tambourine and jingle bells (Ta Da!!) 
-Hits hand on tambourine = 1 
-Hits shaker on something else or hits something else on the tambourine = 1 
-At least one hit w/ shaker on tambourine = 2 
 

GESTURE SCALE 
Finger to lips (Shh, Baby’s sleeping) 
-Says shh w/o gesture = 0 
-Finger to lips w/o “shh” = 2 
 
Clap (Yay, I did it!) 
-Says “Yay, I did it” = 0 
-One clap; the child’s hands are open and come together at midline = 1 
-At least two claps = 2 
 
Point (It went over there!) 
-Says “It went over there!” = 0 
-Points = 2 
 
Hands up and pant (I’m a dog) 
-Says “I’m a dog” = 0 
-Panting = 1 
-Hands up (with or w/o panting) = 2 
 
Finger in circle (It’s spinning!) 
-Says “It’s spinning” = 0 
-Attempts to move fingers or hand in a circular motion; during the child’s attempt at the circular motion, 
their fingers or hands return to the starting point of the motion = 2 
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SEMI STRUCTURED IMITATION SCALE 

GESTURE & OBJECT IMITATION ASSESSMENT 

Id________     Time Period _______  Date_______________ 

Examiner ______________________  Scorer _________________________P    R 

 
TOY SET 

ONE 
ACTION VERBAL MARKER 

TRIAL 
1 

TRIAL 
2 

TRIAL 
3 

SCORE 

Sound tube 
Turn upside down 2 
times 

Whee!     

Train Let train roll off table Oh no!     

Slinky 
Put slinky on nose and 
drop 1 end 

Look!     

Fish & Net Drop fish in net I got it!     

Tambourine 
& Jingle 
bells 

Hit tambourine with 
bells 2 times 

Ta Da!!     

 

TOY SET 
TWO 

PLAY 
ACTION 

GESTURE VERBAL MARKER 
TRIAL 

1 
TRIAL 

2 
TRIAL 

3 
SCORE 

Baby & 
Blanket 

Cover 
baby with 
blanket 

Finger to 
lips 

Shh, Baby’s sleeping     

Blocks 
Make 
tower of 
3 blocks 

Clap Yay, I did it!     

Car 
Push car 
across 

Point to 
car 

It went over there.     

Dog Show toy 
Hands up 
and pant 

I’m a dog.     

Top Spin top 
Finger in 
circle 

It’s spinning.     

**NOTE:  THE CHILD IS NOT SCORED ON WHETHER THEY IMITATE THE PLAY ACTIONS.  
THESE ARE JUST USED BY THE EXAMINER TO PLACE THE GESTURES IN CONTEXT 

Total 
Score 

 

 


